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1 Safety, license and warranty 

Before installing and using your Medialon MAS Pro Dante, please refer to these essential standard 
Medialon documents: 

• M561 End User’s License Agreement for Medialon Software and Plug-Ins, Warranty Terms and 
Conditions for Medialon Hardware 

• M562 Medialon Safety Instructions for installation, use and service 
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2 Medialon MAS Pro Dante 

In this section you will discover the main architecture of MAS Pro (Medialon Audio Server), what 
its main elements are and how they interact with each other. 

This section also helps those who are new to MAS Pro to understand its core engine and ease their 
understanding of the following chapters. 

2.1 Introduction 

MAS Pro (Medialon Audio Server) is a professional audio server for both multi-track application as 
well as multi zoning. 

MAS Pro is designed to ensure maximum reliability for demanding live entertainment or rides 
audio control, as well as for centralized control of large amount of audio channels in museums or 
showrooms. 

MAS Pro allows playback of multiple audio channels. It is not a regular multi-track playback unit 
which plays all files at the same time but a real independent channels server where each file can 
be started when needed. Each of its multiple channels can be synchronized together or by groups. 
Its high-quality Dante interface provides state-of-the-art audio quality. 

Using MAS Pro’s local interface, each channel can be started independently and at any time. 

With Medialon Audio Client Pro software, external control of each channel can be managed 
independently per channel or all together. 

Thanks to MAS Pro’s position tracking capability, programming video and light effects 
synchronized to audio is very easy with Medialon Manager or Showmaster show control products. 

Several MAS Pro audio servers can be linked over IP and synchronized together. 

2.2 Overview of Medialon Audio Server 

MAS Pro is a system which can playback digital audio on up to 128 mono audio output channels. 
Channels may be played either independently or synchronized by groups. The audio files (WAV 
files) played by MAS Pro can be multi-track, and the tracks can be routed to various output 
channels.  
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2.2.1 Main Features 

Hardware/Software Platform 

The MAS Pro is a pre-configured hardware and software package running Windows 10 Enterprise 
LTSC. Configuration and playback control can be done directly on the MAS Pro hardware or from 
Medialon Audio Client software installed on another Windows PC, connected to MAS Pro via the 
network. Medialon show controllers can control and synchronize playback on MAS Pro. Multiple 
simultaneous network connections are supported, so multiple show controllers can be connected, 
each managing different Players, making MAS Pro a true network audio appliance.  

 

Showmaster Go is a compact, rugged show controller and audio server in one small lightweight 
piece of hardware. It is built for mobile applications such as theme park ride vehicles, parade 
floats, trams, and tour busses. It includes both the Medialon Manager show control software and 
the Medialon Audio Server software.  

 

Dante Configurations 

The MAS PRO Dante ‘DC’ models are equipped with dual redundant Dante ports which can provide 
up to 128 audio output channels and can also provide a master clock on the network. 

The MAS PRO Dante ‘D’ models use the on-board NIC and can provide up to 64 audio output 
channels. Note: no master clock is available from these models, as it uses Audinate’s Dante Virtual 
Soundcard. 

Showmaster Go uses the Dante Virtual Soundcard as well, so it is subject to the same limitations as 
the ‘D’ model (16 bit format, 48 kHz sample rate).  
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2.2.2 Architecture 

The following diagram shows Medialon Audio Server architecture. 

 

Audio File Formats 

MAS Pro supports Stereo, Mono, or Multitrack WAV files. Some audio software such as ProTools 
outputs Broadcast WAV files, which contain additional header metadata and are incompatible 
with MAS Pro. It is possible to strip the header metadata from Broadcast WAV files by running 
them through software like Audacity.  

MAS Pro ‘DC’ models support WAV files in 16- or 24-bit format.  
MAS Pro ‘D’ models support WAV files in 16-bit format only. Showmaster Go is considered a ‘D’ 
model for purposes of this limitation. 

See more about Audio File Format. 

Important: MAS Pro only supports 48 kHz sample rate. 

Audio Players 

The MAS Pro can be configured for concurrent use of mono, stereo and multi-track media files. 
Medialon Audio Server uses “Players” to perform these files. 

A Player is defined by one or more audio tracks. The number of tracks correspond to the type of 
file played, i.e. mono (1 track), stereo (2 tracks Left and Right) and multi tracks where the number 
of tracks depends of the file. 
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Audio Output Mapping 

From the user standpoint, MAS Pro manages a set of logical Players. This is done by the following 
logical track and physical output mapping for each Player. 

 

 

Below is a configuration where all of the Players are set to mono. 
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An audio player track can be mapped to several physical outputs. see below a mono Player 
mapped to 4 outputs. 

 

 

Internal mixer and mapping allows sharing the same physical output with several Player tracks. 
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Audio Diagram 

Different audio levels can be adjusted in MAS Pro. 

 

• Player Volume adjusts the audio level of all tracks, it is the master audio level. 

• Track Level adjusts the audio level of each track independently. 

• Output Volume is used to adapt the MAS Pro audio output for the next audio device’s input. 

Stereo players have a specific fader to manage the audio balance left and right. 
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Remote Control 

Although it can be run as a standalone system, MAS Pro’s main purpose is to be controlled from a 
Medialon Control System through a TCP/IP Network. See more about Medialon Control System at 
http://www.medialon.com/. 

A remote client software (Medialon Audio Client) which replicates the local MAS Pro user interface 
is also provided. MAS Pro can also be controlled through a serial connection. 

http://www.medialon.com/
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3 Installation 

In this section you will learn how to correctly connect and start using your Medialon Audio Server. 

3.1 Get Started 

MAS Pro is shipped pre-configured and requires only a few steps to make it ready for use. 

 

3.1.1 Contents of the Package 

• MAS Pro Dante DC (Dante hardware) or MAS Pro Dante D (Dante Virtual Soundcard) 

• 1 × IEC power cord and 12 volt DC adapter 

• 2 × rack mounting brackets (attached) 

3.1.2 Connecting to MAS Pro 

Few connections are required to start your MAS Pro. 

Keyboard, mouse and monitor are needed for the first start and setup. If you plan to control 
remotely your MAS Pro, the keyboard, mouse, and monitor can be removed after the initial setup. 

• MAS Pro Dante DC: Dante Primary and/or Secondary ports must be connected to the Dante 
network. If a secondary (redundant) Dante network is used, it is typically a separate physical 
network, so the Secondary Dante port would be connected to a separate physical network 
switch than the Primary Dante port.  

• MAS Pro Dante D: LAN 1 should be connected to the Dante network in order to use the Dante 
Controller utility which is installed on the MAS Pro. See more about Dante Configuration. 
Use LAN 2 for Ethernet connection and remote control of your Medialon Audio Server. 



Installation 

Medialon MAS Pro Dante User Manual p 15 of 88 
M516-2 | 2020-05-19 

• Showmaster Go: NIC 1 (Lower) should be connected to the Dante network. This network is set 
up for both Dante output as well as for using the Dante Controller utility which is installed on 
Showmaster Go. Use NIC 2 (Upper) for Ethernet connection and remote control of your MAS 
Pro / Showmaster Go. 

Rear Panel – MAS Pro 

 

Left to right (DC model shown): 

• [POWER]: Power Connector 12 V DC 5 A. See Power section for details. 

• [USB 1-2]: USB 3.0 ports available for mouse and keyboard, also used for MAS PRO updates. 

• [DVI]: DVI-D video output connector. 

• [DisplayPort]: DisplayPort 1.2 monitor output 

• [HDMI]: monitor output 

• [LAN 1]: Ethernet connector for Dante mapping (on ‘D’ model, this is the default Dante output.) 

• [LAN 2]: Ethernet connector for external control or FTP. 

• [USB 3-4]: USB 3.0 ports available for general use or MAS Pro updates. 

• [USB 5-6]: USB 2 ports available for general use or for MAS Pro updates. 

• [SERIAL]: serial port used for external control, See more about Serial External Control. 

DC model only: 

• [SYS]: multi-color LED indicating the Dante system status: 

o Green: normal operation. 

o Orange: system failure. 

• [CLK]: multi-color LED indicating the Dante sync status: 

o Green (steady): confirms card is a Dante PTP slave; the card will sync to the clock embedded 
in the incoming Dante bitstream. 

o Green (blinking): confirms card is a Dante PTP master; the card is set (in Dante Controller) to 
generate the Dante clock which will be used by other units. 

o Orange: Sync failure 
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• [ERR]: reserved for future use. 

• [Dante Primary]: Dante port 1. 

• [Dante Secondary]: Dante port 2. 

Rear Panel – Showmaster Go 

 

Left to right: 

• [POWER]: Power Connector 12 - 19 Volts DC 4.7 A. See Power section for details. 

• [DisplayPort 1-4]: DisplayPort monitor outputs. 

• [GPIO]: General Purpose Input/Output connector (used by Medialon Manager). 

• [NIC 1]: Ethernet connector for Dante mapping. 

• [NIC 2]: Ethernet connector for external control, FTP, and Show Control. 

• [USB 1-2]: USB 2.0 ports available for general use or MAS Pro updates. 
 00 

3.1.3 First Start 

We recommend you connect Mouse, Keyboard and Monitor for the first use of MAS Pro. If you 
plan to control the MAS Pro  remotely, the Keyboard, Mouse and Display are not necessary after 
the first setup. 

Front Panel Controls 

The figure below shows the front panel of MAS Pro. 

• [LED]: Four LEDs indicate MAS Pro status. 

• [LCD]: Status messages display on the 4-line LCD. 

• [KP]: Six-button Function Keypad. 
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Use the keypad to scroll through MAS PRO’s status information. 

 

Keypad Functions 

 

OK key Hold this key for more than 1 second to power on MAS Pro. 

Hold this key for more than 4 seconds while the MAS Pro is powered on 
to reset MAS Pro. 

 
Cancel key Hold this key for more than 4 seconds to power off (soft power) MAS 

Pro. 

 

Up arrow Scrolls display up. 

Holding this key for more than 1 second scrolls the display to the home 
position when the button is released. 

 

Down arrow Scrolls display down. 

 
Left arrow Not used. 

 
Right arrow Not used. 

Startup Procedure 

Connect the power supply and press and hold the [OK] key to start MAS Pro. 

The front panel LCD displays the startup message. 
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LCD Display Messages 

Each time an arrow button is pressed, the next line of information is displayed. 

1. [Name] MAS Pro’s user-defined Name. 

2. [Mode] MAS Pro’s current mode: 

o Starting Up: MAS Pro is starting up (from power-on until it is ready) 

o Running: MAS Pro is running . 

o Shutdown: MAS Pro is shutting down.  

o Reboot: MAS Pro is rebooting. 

3. [Vers] MAS PRO’s current firmware version. 

4. [SerN] Serial Number. 

5. [Addr] Current IP address. 

6. [Mask] Subnet mask. 

7. [Gway] IP Gateway address. 

8. [MacA] MAC address. 

LED Status Messages 

Two LEDs give a quick overview of the main status of MAS Pro. 

 

• PWR: Power LED, this LED lights green when power is present, regardless of whether MAS Pro 
is powered on. 

• OS: MAS Pro software LED, this LED indicates the current status of MAS Pro software. 

o Green: MAS Pro software is ready. 

o Yellow: MAS Pro software is starting up. 

o Red: Error, MAS Pro software has an internal system failure. 

o Off: MAS Pro software is not running. 
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Network Settings 

MAS Pro is configured to use DHCP to get its IP address. If your network installation has no DHCP 
server or requires static IP address, this address can be modified via the configuration menu. See 
more about Network Settings Definition. 

3.1.4 MAS PRO Startup Configuration 

MAS Pro is delivered with a default audio configuration. See more about Audio Configuration. 

 

Players Configuration 

At first start, 32 stereo players are available plus one mono+ player. 
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Output Mapping 

Player 33 is a mono track player. This audio track is mapped to all 32 audio outputs. 

 

Each pair of stereo players shares their outputs. 
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3.1.5 Add Audio Files 

Any FTP client software can be used to transfer files to MAS Pro. 

 

MAS Pro FTP parameters: 

• FTP address: MAS Pro IP address. 

• FTP Port: 21. 

• Login username: medialon 

• Login password: medialon 

As an example, here is the procedure to transfer files using a web browser: 

• Start your browser (Internet Explorer, Firefox, Chrome etc.) 

• Type ‘ftp://medialon:medialon@xxx.xxx.xxx.xxx’ (xxx.xxx.xxx.xxx is MAS Pro’s IP address) in the 
address bar and press the Enter key. 
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• The browser page displays the content of the media folder. 

• Drag/drop or copy/paste media files to the folder. 

In addition to FTP, a shared directory has been set up at \\xxx.xxx.xxx.xxx\Sounds\  
You can point Windows to this network location using the same credentials (username: medialon, 
password: medialon)  

3.1.6 Play Audio Files 

1. From the main page, click on the Media Name area corresponding to the player you want to 
use. 

 

2. The media list opens. 

3. Select a file and click Load 

4. Press Play to start the media. 

5. Use volume and balance fader to adjust the audio level. 

 

See more about MAS Pro Interface. 
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4 Using the Audio Server 

In this section you will learn how to use your MAS Pro. 

4.1 MAS Pro Interface 

MAS Pro provides a local user interface in order to play audio files and configure the system. 

4.1.1 The Main Window 

The MAS Pro interface is automatically displayed after the system boots up. 

 

MAS Pro’s main window is composed of a Menu bar, a Status bar and several Player bars. 

Menu Bar 

The MAS Pro interface provides 5 main menus: 

 

• Configuration: this menu allows you to 

o create, open, or save audio configuration files. See more about Configuration Files.  

o edit the audio configuration, see Edit Configuration. 

• Server: use this menu to: 

o setup MAS Pro, see MAS Pro Setup. 

o upgrade your MAS Pro, see Updating MAS Pro. 

o Shutdown or reboot MAS Pro. 

o set the Startup State of the Audio Server, see MAS PRO Startup Status. 
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• Control: this menu provides server playback control, see Menu Control. 

o Audio output volume control. 

o global player commands. 

• Tools: use this menu to launch the Dante Controller utility for the audio network configuration. 

• Help: See more about Help. 

Status Bar 

At the bottom of the MAS Pro interface, there is a Status bar. 

 

The Status bar gives the following information: 

• Status: indicates if the server is online or not. LED turns to green or red. 

 

• Address: it is the connected MAS Pro’s address. 

• Port: it is the TCP Port used by the MAS Pro to listen for client connections. 

• Configuration Synchronization: indicates if the audio configuration is synchronized between 
the server and the client. LED turns to green or red. 

 

• Filename.masConfig: name of the current loaded audio configuration. This section could be 
blank if no configuration is loaded in the Client software. 

• Audio Server: Current version of MAS Pro and its model. 

 

• APU (Audio Processing Unit): represents the  amount of audio processing power used by MAS 
Pro. APU close to 100% may cause sound drops, pops... 
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Player Bar 

A Player Bar provides the necessary controls and displays related to that Player. The number of 
Player bars depends of the audio configuration. The window can be scrolled with the vertical scroll 
bar located at the right of the window. 

 

Details of all controls are shown in the following paragraphs. 

Click on the index icon to open the Player Details window. 

4.1.2 Player Details 

The Player Details window gives access to the same Player controls available in the main window. 
In addition, you can also act on each audio track available in the Player. 

The following paragraphs detail the use of the elements of a Player. 

 

Player Controls 

This section is common to the Player bar in the main window. 

Player Name 

 



Using the Audio Server 

Medialon MAS Pro Dante User Manual p 26 of 88 
M516-2 | 2020-05-19 

This is the name of the Player. 

You can change the Player’s name when you edit the MAS Pro configuration. 

Each Player is also identified by a Player Index. 

In main window, click on the index icon to open the Player Details window. 

Media Name 

This text box shows the name of the audio file currently loaded on the Audio Player. It is blank if 
no media is loaded. 

To load media: 

 

• Click on the Media Name text box to open the Media Library. 

• This displays a media selector which shows all available audio files. 

 

• Select an audio file and click the OK button (or double-click on the file name). 

• The audio file name appears in the Media Name text box if it is successfully loaded.  

• Click on Unload button to close the media. This clears the Media Name text display showing the 
Player has no media to play. 

Consult Add Audio Files to add new audio files. 
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Transport Commands 

Play, Pause and Stop commands are available in the Control section. 

 

 Click on the Loop toggle button to turn  media looping On or Off. 

Volume 

The Volume slider sets the volume of the Player: 

 

• Move the slider to its rightmost position for full volume. 

• Move the slider to the leftmost position to mute the Audio Player. 

Hold the CTRL key to move all volume sliders to the same level. 

Balance 

A Balance slider is available with stereo players. With it, you can adjust the proportion between 
the left and right audio track. 

Mono/Stereo/Multi 

Players can be Stereo, Mono, or Multitrack ; the Mono/ST display indicates the type of Player: 

 

• Mono: Player with 1 audio track mapped to 1 audio output. 

• Mono+: Player with 1 track mapped to several outputs. 

• Stereo: Player with 2 audio tracks, each track mapped to a different output. 
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• Stereo+: Player with 2 audio tracks, audio tracks are mapped to several outputs or to the same 
output. 

• Multi: Player with more than 2 audio tracks, each track goes to a different output. 

• Multi+: Player with more than 2 audio tracks, audio tracks are mapped to several outputs or to 
the same output. 

Status 

This text box shows the status of the Player: 

 

Different Player Status are: 

• Idle: no media file has been loaded on this Player since MAS PRO power up 

• Open: a media file is loaded on this Player 

• Closed: the media file couldn’t be loaded 

• Playing: the media is playing 

• Paused: the media is paused 

• Stopped: the media is stopped 

• Not Online: the Medialon Audio Server is not online 

TimeCode / Duration 

TimeCode shows the current position of the media: 

 

TimeCode is displayed with hundredth of second unit precision. The format is hh:mm:ss/ff where: 

hh = Hours 

mm = Minutes 

ss = Seconds 

ff = Hundredths of seconds 

The media duration is set to 00:00:00/00 if no audio file is loaded. 
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Track Controls 

This section presents the audio track controls; the number of tracks depends on the Player’s 
configuration. 

 

This section also displays the output mapping. 

Track Name 

This is the name of the Audio track: 

 

You can change this name when you edit the MAS Pro configuration. Each Audio track is also 
identified by a track Index. 

Track Volume 

The Volume slider sets the volume of the Audio track. 

 

• Move the slider to its rightmost position for full volume. 

• Move the slider to the leftmost position to mute the Audio Track. 

Hold the CTRL key to move all track volume sliders to the same level. 
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4.1.3 Control Menu 

 

Output Volume 

The Volume sliders set the volume of the Audio outputs. 

 

• Move the slider to its rightmost position for full volume. 

• Move the slider to the leftmost position to mute the Audio Output. 

Hold the CTRL key to move all volume sliders to the same level. 
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Command All Players 

With these commands (Play, Pause, Stop, Load/Unload media, Loop On/Off), you send the order 
to all the Players present in the MAS Pro at the same time. 

4.1.4 Shutdown / Reboot 

The MAS Pro can be shut down or rebooted by using the Server Menu. 

 

These functionalities are available on the Medialon Audio Client when a connection is established 
with an Audio Server (Status Online). 

4.2 Audio Configuration 

MAS Pro can be used with different audio configurations. 

4.2.1 Configuration Management 

The audio configuration can be edited with the local interface or remotely from a Medialon Audio 
Client Pro software. 

Configuration Files 

MAS Pro audio configurations can be saved as files. 

• Go to Configuration menu: 

  

• New Configuration: create a new empty configuration. 
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• Load Configuration: load an existing configuration file. 

 

• Save Configuration: save the current configuration. 

• Save Configuration as: save the current configuration into a new file. 

 

Configuration Files Location 

Configuration files are saved in a folder called “ConfigFiles”. 
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This folder is accessible with the FTP connection. See more about FTP Server. 

Edit Configuration 

Medialon Audio Server PRO audio configuration can be edited even if you are disconnected from 
the MAS PRO. 

• Go to Configuration menu and select Edit Configuration. 

 

• Or use [CTRL+E] on your keyboard to open the Configuration editor. 

 

• Once your audio configuration is completed, click on Ok button to validate it. 

Each time you send a configuration, MAS PRO is reset and all media are unloaded. 

4.2.2 Players Configuration 

A MAS PRO Player is the logical entity where audio files are loaded and played. A player is defined 
by one or several audio tracks corresponding to the type of recording. 
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Medialon Audio Server can host as many players as you need. 

Add New Player 

To add a Player in your configuration: 

1. Use the right click menu or [CTRL+P] shortcut. 

 

2. You can give a name to the player. Medialon Audio Server attributes an automatic player name 
based on the index in the player list. 

 

With the right click menu, you can also rename the player or delete it. 

Add New Tracks 

Once a player is created, you need to add one or more tracks to play the audio. 

1. Select a Player 

2. Use the right click menu or [CTRL+T] shortcut. 
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3. You can give a name to the tracks. Medialon Audio Server attributes an automatic track name 
based on the index in the player track list. 

 

With the right click menu, you can also rename the track or delete it. 

Output Mapping 

Once player and tracks are created, you need to select the physical audio outputs used to perform 
the audio file. 

1. Select a track 

2. Use the right click menu or [CTRL+M] shortcut. 
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3. Select one or several outputs in the right list. 

 

4. Click on the Add Outputs  button to route the track to the selected outputs. 

5. Click on OK to validate the output mapping. You can change the output mapping, execute step 
1 and 2 as described above. 
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6. Select on the left list the outputs you want to remove. 

7. Click on the Remove Outputs  button to unroute the track. 

Players List 

From the Players tabs, you can expand or collapse the players configuration 

 

4.2.3 Outputs Configuration 

Physical outputs can renamed, the output mapping will be easier to do. 

1. Select an output. 

2. Right click to rename it. 
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3. Click on Ok button to validate the new output names. 

New output names are not changed in the Player output mapping until you validate your 
changes. 

 

4.2.4 MAS PRO Startup Status 

Once the audio configuration of your Medialon Audio Server PRO is completed, you can also 
define a default status for all players. This default status will be loaded each time Medialon Audio 
Server PRO will power on. 

This startup status contains: 

• Media file loaded or not in each player. 

• Volume and Track level for each Player. 

• Transport command (Play or Stop, Repeat) for each Player. 

• Audio Output levels. 
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Save a startup state 

1. Load and start or not media files in the players 

2. Set all audio levels 

3. Activate the play repeat where it is needed. 

4. Goto Server menu. 

 

5. Select “Save Current Audio Server State as Startup State”. 

Warning! the startup state is deleted each time you send a configuration to the server. 

4.2.5 Tools 

The Dante Controller utility can be launched from the Tools menu in order to route the MAS Pro 
outputs with other external devices. 
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5 Remote Control 

This section will teach you different ways to control your Medialon Audio Server. 

5.1 Medialon Audio Client Pro 

A remote client software is provided on the Medialon website. This program, named Medialon 
Audio Client Pro allows to interact with the Medialon Audio Server from any Windows based 
personal computer (for example, a laptop). Basically, this software emulates the same user 
interface as the local Medialon Audio Server PRO user interface. 

5.1.1 Client Installation 

Medialon Software Products are compatible with Windows 10 (32-bit). However, they can run on 
Windows 64-bit platforms (Windows 10 64-bit) in 32-bit compatibility mode. 

To install Medialon Audio Client Pro software: 

1. Launch the MedialonAudioClientPro.X.X.X_Setup.exe installer. 

2. Read the Software License Agreement, then click “I accept”. 

3. Click “Next” on the Welcome page. 

4. Select the destination folder location and click “Next”. 

5. Select the Start Menu folder for program shortcuts and click “Next”. 

6. Choose to have a desktop icon and click “Next”. 

7. Review your choices and click “Next” to install the program. 

8. Click “Finish” to complete Medialon Audio Client Pro installation. 

5.1.2 Starting Medialon Audio Client Pro 

Start the Audio Client Pro from Start > Programs > Medialon > Medialon Audio Client Pro. 

 

https://www.medialon.com/
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Note: If Firewall activated, there may be a message box asking to block or unblock the 
communication port used by the Medialon Audio Client PRO. Choose “Unblock” and click “OK”. 

5.1.3 Connection to MAS Pro 

Start a connection 

Select “Connect” in the “Server” menu item: this will open the Server connection dialog box. 

 

 

• Server Address: Enter the IP Address or computer name of the MAS Pro. 

• Browse: Use this button to start a network scan and detect all MAS Pro audio servers present 
on the network. 

Network scan is not able to detect MAS24-96 “Legacy” models. 
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• Server Listen Port: Enter the IP Port used by the MAS Pro to listen to new client. Don’t change 
this value (default is “6543”) unless this setting has been modified in the MAS Pro. 

• Client Listen Port: Enter the IP Port opened by Medialon Audio Client software to communicate 
with the MAS Pro. Don’t change this value (default is “4321”) unless this port is already used on 
the client computer. 

• Connect: use this button to open the connection. 

MAS PRO Connected 

When connection is established, status bar will indicate if client audio configuration is 
synchronized with the configuration on the MAS Pro hardware. 

 

When audio configuration is different between the server and the client, the Configuration 
Synchronization LED turns to red. 

 

5.1.4 Setting Audio Configuration 

Whether you are connected to a MAS PRO or not, the Audio configuration can be changed. 

Edit Configuration 

With Medialon Audio Client software you can edit the audio configuration. 
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Even if MAS Pro is not Online, you can create a new audio configuration. See more about Audio 
Configuration. 

 

If you don’t send the configuration to the server, the Medialon Audio Client software displays a 
non-sync configuration. 

 

When a player name does not match with the current server configuration, player status turns to 
“Not Sync”. 

You can also work on the audio configuration offline. 

 

Configuration Synchronization 

After any change in the audio configuration, the server and the client are desynchronized. 

 

From this state you can execute a synchronization in one direction or the other. 

• Go to Server menu. 
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• Select ‘Retrieve Configuration ...’ to synchronize your client. 

• Select ‘Send Configuration ...’ to push the Medialon Audio Client software’s configuration to 
the MAS Pro hardware. 

 

Configuration Synchronization LED turns to green when Client and Server are in sync. 

Configuration Files 

The MAS Pro audio configuration can be saved as files. 

  

In this way you can keep a copy of your different configurations in your Client host PC. 

5.1.5 Using Medialon Audio Client software 

At startup Medialon Audio Client software automatically connects to the last specified MAS Pro 
and retrieves its audio configuration. 
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The Medialon Audio Client software replicates the main window and the player bars of the MAS 
Pro’s local interface. See more about MAS Pro Interface. 

Status 

This text box shows the status of the Player: 

 

Different Player Status are: 

• Idle: no media file has been loaded on this Player since MAS Pro was powered up. 

• Open: a media file is loaded on this Player. 

• Closed: the media file couldn’t be loaded. Playing: the media is playing. 

• Paused: the media is paused 

• Stopped: the media is stopped 

• Not Online: the MAS Pro is not online. 

• Not Sync: the MAS Pro Audio Configuration is not synchronized. Configuration Synchronization 
LED is also red to indicate this Not Sync status. 

Load media file and volume adjustment can only be done when Medialon Audio Client PRO is 
connected to a MAS. 

5.1.6 Controlling Medialon Audio Server (MAS 24-96) 

It is possible to use Medialon Audio Client software to control a Medialon Audio Server first 
generation. 
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MAS 24-96 Configuration 

With these models the audio configuration is static (24/48/72/96 audio outputs), when Medialon 
Audio Client software is connected to one of these models, a Legacy Models configuration is 
automatically loaded. 

 

This legacy configuration gives access to 96 stereo players mapped to a pair of outputs. 

 

It is not possible to retrieve or to transmit another configuration to the MAS (legacy version). 
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Players cannot be edited, and Player details are not available. there is no track audio level in this 
configuration. 

 

Mono/Stereo and Balance 

Stereo Players can be used as Stereo or Mono channel. 

 

Click on the Mono/Stereo control to switch between mono or stereo mode. 

In stereo mode, the Balance slider sets the balance between the physical left and right outputs of 
the Audio Channel. 

For example: the Audio Player with an ID of 3 will route its audio to physical outputs 3 and 4. 

 

In Mono mode, the Balance slider is not shown, and the audio signal is routed to the same physical 
output as the Audio Player ID. 
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5.2 Medialon Control System 

MAS Pro can be controlled remotely from Medialon Showmaster hardware or Medialon Manager 
show control software. 

 

Medialon Control System software controls audiovisual devices through the use of a software 
plug-in called MxMs. The MxM for Medialon Audio Server fully integrates one or more MAS Pro 
servers in a show installation. 
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Audio Players are declared as Medialon Devices. 

 

 

The list of available Players can be retrieved from the MAS Pro. 

Medialon Control System offers the capability to create group of players to insure the synchronous 
execution of a command for this group of players. Several commands like Play, Pause, Stop, Locate 
are concerned. For more about MxM Medialon Audio Server see the Medialon Control System 
user manual. 

To discover the power of Medialon Control System, visit the Medialon website. 
  

https://www.medialon.com/
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5.3 Serial External Control 

MAS Pro is designed to be controlled remotely from another system by using serial connection. 

 

Connect an RS232 cross cable to the SERIAL port on the rear of MAS Pro and use HyperTerminal 
for external commands. 

RS232 Wiring Diagram 

PC (sub D9 F) Pin  Pin MAS Pro (sub D9 F) 

TxD 2  3 RxD 

RxD 3  2 TxD 

GND 5  5 GND 

Refer to the RS232 Protocol for command details. 

HyperTerminal 

Medialon Audio Server RS232 (serial) may require 
a serial to USB adapter 
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6 Maintenance 

In this section, you will learn how to maintain your MAS Pro audio server. 

6.1 Medialon Audio Server Setup 

MAS Pro settings are changed locally on the MAS Pro hardware. Remote Medialon Audio Client 
software cannot change the system setup. 

Clicking on the “Server > Setup...” menu item displays the Setup dialog box which allows to set up 
various system parameters of the MAS Pro. 

 

6.1.1 LAN 1 

It is recommended to plug the LAN 1 on the Audio network (Dante) in order to use the Dante 
controller utility. MAS Pro is configured to use DHCP to get its IP address. If your network 
installation has no DHCP server or requires another IP address, open the Setup menu and change 
the Network settings. 
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• IP Address: defines the network address of the MAS Pro. You may need to modify it if the 
default IP Address doesn’t match your network configuration. 

• IP Mask: defines the network subnet the MAS Pro belongs to. 

• IP Gateway: defines the network gateway. 

• DHCP: use DHCP for automatic IP address. 

• Primary DNS: only required if you want your MAS Pro to access the Internet (not 
recommended) 

• Secondary DNS: only required if you want your MAS Pro to access the Internet (not 
recommended) 

Network settings should be changed with caution, improper settings may cause a malfunction of 
the MAS Pro. 

6.1.2 LAN 2 

LAN 2 should be use for remote control. It is better to separate the remote control network and 
the Audio network (Dante). MAS Pro is configured to use DHCP to get its IP address. If your 
network installation has no DHCP server or requires another IP address, open the Setup menu and 
change the Network settings. 

 

• IP Address: defines the network address of the MAS PRO. You may need to modify it if the 
default IP Address doesn’t match your network configuration. 

• IP Mask: defines the network subnet the MAS PRO belongs to. IP Gateway: defines the network 
gateway. 

• DHCP: use DHCP for automatic IP address. 

• Primary DNS: only required if you want your MAS Pro to access the Internet (not 
recommended) 
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• Secondary DNS: only required if you want your MAS Pro to access the Internet (not 
recommended) 

Network settings should be changed with caution, improper settings may cause a malfunction of 
the MAS Pro. 

6.1.3 Remote Control 

 

Network Settings 

MAS Pro can be controlled remotely by using the Medialon Audio Client software or the 
mxmMedialonAudioClient. 

• Server Listen Port: this value doesn’t need to be modified unless a special configuration of your 
network doesn’t allow this port. The default value is 6543. 

Serial Port Settings 

MAS Pro can be controlled through its SERIAL port and a RS232 communication. 

• Baud Rate: select speed of communication. 

6.1.4 Audio Parameters 

In this section, you set the type of audio files used with MAS Pro. 



Maintenance 

Medialon MAS Pro Dante User Manual p 54 of 88 
M516-2 | 2020-05-19 

 

• Sample Rate: The sample rate is fixed at 48kHz for the audio files. 

• Sample Format: defines the quality of the sound played by the MAS Pro. By default, sample 
format is set to 16 bits. To obtain the best audio quality, you can use 24 bits audio files and 
configure MAS Pro to 24 bits format (24 bit format is only applicable to MAS Pro DC models). 

• Sample Frames: defines the size of the audio buffer. This parameter is reserved to expert, the 
default value (1024) covers all typical installations. 

Any change in Audio Parameters will reboot the MAS Pro. 

6.2 Updating Medialon Audio Server 

This section helps you upgrade the software on your MAS Pro. 

Download the latest Medialon Audio Server from the Medialon website. 

https://www.medialon.com/
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• Download the Medialon Audio Server Firmware Update Package 

• Unzip “MedialonPackage_Sx.x.x_Cx.x.x.zip” file at the root of a USB disk. 

• Insert the USB disk into the MAS Pro 

For more information about MAS Pro updates, contact your dealer 
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6.2.1 Method for MAS Pro Client 2.1.6 / Server 2.1.5 and 
greater 

1. Select Server > Update Medialon Audio Server menu. 

 

2. Select Medialon Audio Server firmware (.masx) you want to install (this is showing the USB 
drive). 

 

3. Start the update. 

 

4. MAS Pro closes its main interface, executes the update and then reboots to complete the 
update. 
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6.2.2 Method for MAS Pro Client 2.1.5 / Server 2.1.4 and earlier 
versions 

1. Select Option > Update Medialon Audio Server menu. 

 

2. Start the update. MAS Pro looks for a “MedialonAudioServerXXX.ZIP” file in a folder named 
“Medialon Update” at the root of a USB disk. 

 

3. MAS Pro closes its main interface, executes the update and then reboots to complete the 
update. 

If any valid update file is not detected, a warning message is displayed. 
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7 References 

7.1 Specifications 

 

7.1.1 Rack Mount 

WARNING – The unit is intended to be rack mounted as per applicable requirements so no 
imbalance likely to occur and adequate clearance is to be provided so ambient temperature does 
not exceed the limit. Please see Mandatory Safety Rules and Precautions section. 

Installation 

Note: You need a #2 Phillips screwdriver for rack mount installation. Complete the following steps 
to mount devices in a rack: 

• Remove the rack mount kit from the shipping carton. The kit contains two L-shaped mounting 
brackets and four sink-head screws. The rack ears may be attached prior to shipping. 

• Using a Phillips screwdriver, attach the mounting brackets to the sides of the device using four 
sink-head screws. 

• Using a Phillips screwdriver, mount the device in the rack using four rack-mounting screws. 

7.1.2 MAS Pro Hardware 

Hardware Specification 

• Storage: SSD with 256 GB of storage 

System 

• CPU: Intel® Core i3-7101E processor 

• System Chipset: Intel C236 

• Memory: 4 GB DDR3 2666 MHz 

• H/W Status Monitor: Monitoring temperatures, voltages, and cooling fan status. Auto 
throttling control when CPU overheats 
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Display 

• Chipset: Intel C236 chipset supports 3 displays (2x DisplayPort 1.2, 1x HDMI 1.4, 1x DVI-D) 

Ethernet 

• LAN1: Gigabit LAN  

• LAN2: Gigabit LAN  

• Wake on LAN supported 

Mechanical & Environment 

• Rack 19’’ xU 

• Power Type: 12 volts DC, 7 amps max 

• Operating Temperature: 32°F – 104°F (0°C – 40°C) 

• Storage Temperature: -4°F – 185°F (-20°C – 85°C) 

• Operating Humidity: 10 – 80% RH non-condensing 

• Storage Humidity: 5 – 90% RH non-condensing 

• Operating Altitude: sea level to 2000 meters 

Power 

• External Power Adapter EDACPOWER ELEC 

• Model EA10523C-120 

• AC Input: 100-240 V AC – 1.8 A, 50-60 Hz 

• DC Output: 12 V DC 7 A 

• Connector: DC-Jack 

Approvals 

• FCC 47 CFR Part 15 Subpart B 

• ICES-003 Canada 

• EN 55032 

• IEC 61000-3-2 & IEC 61000-3-3 

• EN 55024 
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• IEC-61000-4-2 & IEC-61000-4-3 & IEC-61000-4-4 & IEC-61000-4-5 & IEC-61000-4-6 & IEC- 
61000-4-11 

• IEC/EN/ UL 62368-1 

• CSA C22.2#62368-1 

• IEC 60950-1 

• STL 

Dante Output 

• Type: Gigabit Ethernet interface 

• Connector: RJ45 

• Precision: 16 or 24 bit 

• Sample Rate: 48 kHz 

• Latency: 1 ms, 2 ms, 5 ms 

Signal Processing 

• DSP Texas Instruments TMS320C6713@300 MHz 

• Memory: 8 MB 

• Audio Formats: 16-, 24-bit signed PCM 

Software Specification 

• Medialon Audio Server V2 

• Windows 10 Enterprise LTSC 

FTP Server 

• FTP address: MAS Pro IP address 

• FTP Port: 21 

• Login username: medialon 

• Login password: medialon 

• Root folder: Audio files storage 

• Sub folder: “ConfigFiles”: Configurations files storage 
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7.1.3 Audio File Format 

WAV file format: 16 bit or 24 bit /48KHz 

7.2 Dante 

Dante is a combination of software, hardware, and network protocols that deliver uncompressed, 
multi-channel, low-latency digital audio over a standard Ethernet network. Developed in 2006 by a 
Sydney-based company named Audinate, Dante builds and improves on previous audio over 
Ethernet technologies, such as CobraNet® and EtherSound. Like most other audio over Ethernet 
technologies, Dante is primarily for professional, commercial applications. Most often, it is used in 
applications where a large number of audio channels must be transmitted over relatively long 
distances or to multiple locations. 

Dante provides several advantages over traditional analog audio distribution. Audio transmitted 
over analog cables can be adversely affected by signal degradation due to electromagnetic 
interference, high- frequency attenuation, and voltage drop over long cable runs. Thanks to digital 
multiplexing, the cabling requirements for digital audio distribution are almost always reduced 
when compared to analog audio. Dante also provides specific advantages over first-generation 
audio over Ethernet technologies, such as CobraNet and EtherSound. Technological advancements 
include the ability to pass through network routers, native gigabit support, higher channel count, 
lower latency, and automatic configuration. 

7.2.1 Dante Overview 

Dante Terminology 

• Transmit (Tx) channel: A transmit channel transmits audio from the audio hardware onto the 
network. 

• Receive (Rx) channel: A receive channel receives audio from the network and sends it to the 
audio hardware. 

• Flow: Dante audio routing creates flows. Each flow carries several channels of audio from a 
transmitter to one or more receivers. Unicast routing creates flows to single receivers. 
Multicast routing creates flows that can be received by multiple receivers. Multicast flows are 
assigned IDs enabling them to be identified in Dante Controller. 

• Unicast routing: Unicast flows are point-to-point from a single transmitter to a single receiver. 
Unicast flows typically have room for 4 channels of audio. 

• Multicast routing: Multicast flows are one-to-many from a single transmitter to any number of 
receivers. Unlike unicast routing, multicast flows consume network bandwidth even if there are 
no receivers, but do not require additional bandwidth to add more receivers. 
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Network recommendations 

Make certain that your network is using good quality components and is running Gigabit 
throughout. This helps reducing latency and increases bandwidth flexibility. 

As a rule of thumb, a separate dedicated Dante network is recommended for critical, high channel-
count applications. 

Audio Formats 

Different Dante devices may support different audio formats. Most Dante devices support either 
48 kHz 24-bit PCM or 96 kHz 24-bit PCM. Some devices can be switched between 48 kHz and 
96 kHz, but will not support both at once. 

It is only possible to set up a route between channels which have a common audio format. 
Channels having incompatible formats will not be routable. 

Note: The MAS Pro Dante Audio Format is 48 kHz 16-bit (‘D’ and ‘DC’ models) or 24-bit (‘DC’ 
models only). 

Flows 

Dante audio routing creates ‘flows’. Each flow carries one or more channels of audio from a 
transmitting device to one or more receiving devices. There are two types of flow, unicast and 
multicast. 

Unicast routing creates flows to a single receiving device; a unicast flow typically assigns space for 
4 channels of audio. Unicast flows are setup when a receiver subscribes to an available audio 
channel and are automatically removed when the receiver unsubscribes from all channels in that 
flow. 

Multicast routing creates flows that can be received by multiple receivers. Multicast flows are 
assigned IDs enabling them to be identified and to facilitate their removal. In contrast to unicast 
flows, multicast flows must be set up on the transmitting Dante device before receivers can 
subscribe to these flows. 

Advanced Routing: Using Multicast 

Dante routing is unicast by default. This means that a separate flow is set up between each 
transmitter and receiver. If several receivers are all subscribed to the same channels of a 
transmitter, it may sometimes be more efficient to use multicast. 

Multicast sends the same set of channels to multiple receivers. In practice, this usually means that 
the audio flow is flooded throughout the network. If many receivers want the same channels, 
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using multicast can reduce overall network use, especially on the transmitter, because only one 
copy of each audio channel needs to be sent, rather than many. 

Dante receivers will automatically prefer multicast to unicast if it is available. This means that if a 
new multicast flow is created containing the channels that a receiver is currently receiving as 
unicast, the receiver will switch over to receiving audio from the multicast flow and the unicast 
flow will be removed. 

7.2.2 Dante Configuration 

MAS Pro is made with 1 Dante Port or Device. Its Dante configuration is done by using Dante 
Controller utility which can be downloaded from Audinate website. 

This utility is also installed on MAS Pro and it can be opened from the Tools menu. 

 

 

Dante Controller is a software application provided by Audinate which allows users to configure 
and route audio around Dante networks. 

It is available for PCs running Windows 7, 8 and 10, and Apple Macs running OS X 10.6.8 or newer. 

https://www.audinate.com/
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Once you install Dante Controller on your PC or Mac and connect it to a Dante network, you can 
use Dante Controller to: 

• View all Dante-enabled audio devices and their channels on the network 

• View Dante, enabled device clock and network settings 

• Route audio on these devices, and view the state of existing audio routes 

• Change the labels of audio channels from numbers to names that suit you 

• Customize the receive latency (latency before play out) 

• Save audio routing presets 

• Apply previously saved presets 

• View and set per device configuration options including: 

o Changing the device name 

o Changing sample rate and clock settings 

o Viewing detailed network information 

o Access the device web page to upgrade firmware and license information (where 
supported) 

o Identify a device for example by flashing LEDs (where supported) 

Audio Routing 

When Dante Controller is started, it always displays the Routing Tab within the Network View. In 
this view the network is shown in the form of a grid. Devices with Tx channels are displayed along 
the top row of the grid, and those with Rx channels are displayed along the left-hand column of 
the grid. Initially a collapsed view is presented; individual channels cannot be seen. 

Note: If a device name is shown in red, it means Dante Controller has automatically detected an 
error condition. Double-click the device name to see more information. 

Note: If a device has Tx and Rx channels, it is shown both along the top row of the grid and also 
along the left-hand edge. 
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Even if MAS Pro is detected as a receiver/transmitter in Dante controller, only the 
transmitter part is really available. MAS Pro Dante inputs should not be routed. 

Clock Source Configuration 

All Dante-enabled devices use the IEEE 1588 Precision Time Protocol (PTP) across the network to 
synchronize their local clocks to a master clock, providing sample-accurate time alignment 
throughout the network. 

One Dante device will be elected as the PTP Master Clock for the network; all other Dante devices 
act as a PTP Slave Clocks to the elected master clock. Although many Dante devices may be 
capable of becoming PTP Master Clock, only one device will win the election. Devices with clock 
inputs (e.g. word clock or AES3) will be preferred in the election process. A gigabit connected 
device is preferred over a device connected via 100Mbps. A tie-breaker rule of the lowest MAC 
address is used if several equivalent candidate master clocks are available. The election process 
may be overridden by manually setting ‘PTP Preferred’ master on a device. 
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The MAS Pro Dante ‘DC’ model provides a high-quality on-board word clock, that means that the 
MAS Pro can be configurated as preferred Master Clock on the Dante Network if needed. 

 

Latency 

In Dante, variation in latency in the network is compensated for at the receiver. Each receiver has 
an Rx latency setting. This setting defines the latency between the timestamps on the incoming 
audio samples and when those samples are played out. 

The typical default latency for a Dante device is 1ms. This is sufficient for a very large network, 
consisting of a Gigabit network core (with up to 10 hops between edge switches) and 100 Mb links 
to Dante devices. Smaller, Gigabit-only networks can use lower values of latency (down to below 
0.2 ms). We recommend setting the latency at 5 ms, which is safer. 
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Note: The minimum latency available for a device connected to a 100 Mbps network port is 1 ms. 

7.3 RS232 Protocol 

7.3.1 Overview 

The MAS Pro ASCII control protocol is a client/server protocol. Requests are always initiated by the 
client and the server must reply to the client requests. There’s no concept of ‘event’ messages 
which would be sent by the server without a request. 

The underlying transport protocol is ASCII over a serial link (RS232) although the protocol itself is 
independent of the physical transport protocol. 
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RS232 Communication parameters 

Parameter Data 

Baud rate 38400 to 115200 baud 

Databits 8 

Parity No 

Stopbits 1 

Flow control None 

General message format 

Syntax 

A command is made of: 

• A verb 

• Zero, one or more parameters separated by commas and enclosed by brackets. 

Example: “PLAY(2)” 

A single command message is made of a command followed by a carriage return (0x13) or a line 
feed (0x0A). 

Note: the verb is not case sensitive: that is “OpenMedia” is the same as “OPENMedia”. Space 
characters (SPACE or TAB) are allowed: 

• between verb and left brackets 

• between parameters and separators (brackets and comma). 

Example: “OPENMEDIA ( 2, testmedia.wav )\n”. 

However, reply messages returned from the server are guaranteed not to contain any spaces 
between verb, left brackets, parameters and right brackets. 

A message can be made of one or more commands. Commands must be separated by one or more 
space character(s). The end of the message is delimited by a carriage return (0x0D or \r) or a line 
feed (0x0A or \n). 

Example: “PLAY(2) STOP(4)\r” 

Messages returned by the server always contain only one reply for each command. 



References 

Medialon MAS Pro Dante User Manual p 69 of 88 
M516-2 | 2020-05-19 

Time values sent by the client are expressed either: 

• as timecode string in hundredth of seconds format. 

Example: “00:01:00/52” means one minute and 52 hundredth 

• as time in milliseconds 

Example: “60520” means one minute and 52 hundredth. 

Each verb has shortcut in order to optimize communication throughput and/or ease typing the 
command on a terminal. See detail command description. 

Example: “PLAY(2)” or “PL(2)” commands are equivalent. 

Server Response 

When MAS Pro receives a “command only” message. It sends back the command message, If the 
command is correctly formatted. 

Example: Send a play command to Player #2: 

• Client sends: PLAY(2) 

• The server replies: PLAY(2). 

When MAS Pro receives a “get information” message, the server sends back the requested 
information preceded by the same verb as the request message. 

Example: In order to get the status of Player #4: 

• Client sends: GETSTATUS( 4 ) 

• Server replies: GETSTATUS(4,3,00:05:23/45) 

Error management: 

If the command syntax is incorrect, the server sends back an error message followed by the 
incoming command. 

Example: send a play command to Player #212 (which doesn’t exist): 

• Client sends: PLAY(212) 

• The server sends back: Error(Invalid Channel) PLAY(212) 

Note that no error is notified if the command syntax is correct, but the required action couldn’t be 
performed depending upon the current state of the server. 
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The only exception is the OpenMedia() command which returns a “File Not Found” error if the 
specified media is not in the media directory. 

It is allowed to send a command to the server before receiving the reply of the server for the 
previous command. 

Group of Players 

To ensure the synchronous execution of a command for a group of Players, several commands like 
Play, Pause, Stop, support multiple Players. 

Example: PLAY(1,4,9,10) can be used to start playing Players 1, 4, 9 and 10 in sync. 

7.3.2 Commands 

Command shortcuts are shown within brackets. 

Transport 

PLAY 

Send a Play to the specified Player(s). 

Client sends: 

Field Value 

Command PLAY [PL] 

PlayerIndex 1 to N 

Server replies with the same message: 

Example: PLAY(2) 

This command also supports multiple Players using the following syntax: PLAY(,,...,) 

Example: PLAY(1,4,9,10) can be used to start playing Players 1, 4, 9 and 10 in sync. 

PAUSE 

Send a Pause to the specified Player(s). 
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Client sends: 

Field Value 

Command PAUSE [PA] 

PlayerIndex 1 to N 

Server replies with the same message: 

Example: PAUSE(2) This command also supports multiple Players using the following syntax: 
PAUSE(,,...,) 

Example: PAUSE(1,4,9,10) can be used to pause Players 1, 4, 9 and 10 in sync. 

STOP 

Send a Stop to the specified Player(s). 

Client sends: 

Field Value 

Command STOP [ST] 

PlayerIndex 1 to N 

Server replies with the same message: 

Example: STOP(2) 

This command also supports multiple Players using the following syntax: STOP(,,...,) 

Example: STOP(1,4,9,10) can be used to stop Players 1, 4, 9 and 10 in sync. 

LOCATE 

Locate the specified Player to the specified position. 

Client sends: 

Field Value 

Command LOCATE [LC] 

PlayerIndex 1 to N 

Position position to locate to (either in timecode or milliseconds format) 

Server replies with the same message: 



References 

Medialon MAS Pro Dante User Manual p 72 of 88 
M516-2 | 2020-05-19 

Example: LOCATE(2,00:03:25/45) 

This command also supports multiple Player channels using the following syntax: 
LOCATE(,,...,,Position) 

Example: STOP(1,4,9,10,00:01:00/00) can be used to locate Players 1, 4, 9 and 10 at the specified 
position. 

OPENMEDIA 

Open and load a media on the specified Player. 

Client sends: 

Field Value 

Command OPENMEDIA [OP] 

PlayerIndex 1 to N 

MediaName Media Name 

Server replies with the same message: 

Example: OPENMEDIA(4,testfile.wav) 

If successful, this command increments the Player’s OpenFileCounter (See GETSTATUS command). 

CLOSEMEDIA 

Close the currently loaded media on the specified Player. 

Client sends: 

Field Value 

Command CLOSEMEDIA [CL] 

PlayerIndex 1 to N 

Server replies with the same message: 

Example: CLOSEMEDIA(4) 
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SETVOLUME 

Set the volume for the specified Player. 

Client sends: 

Field Value 

Command SETVOLUME [VO] 

PlayerIndex 1 to N 

Volume Volume gain in hundredth of dB (from 0dB to -100dB) 

Server replies with the same message: 

Example: SETVOLUME (4,-1000). 

SETBALANCE 

Set the balance for the specified Player. 

Client sends: 

Field Value 

Command SETBALANCE [BA] 

PlayerIndex 1 to N 

Balance Balance in hundredth of dB. Positive values for right channel, negative values for left channel. 

Server replies with the same message: 

Example: SETBALANCE (4,1000). 

SETLOOP 

Sets the number of times the current media should be looped on the specified Player. 

Client sends: 

Field Value 

Command SETLOOP [LP] 

PlayerIndex 1 to N 

PlayCount Number of times the media must loop after this command has been received. 0 means infinite loop. 

Server replies with the same message: 
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Example: SETLOOP(12,3). 

Send SETLOOP(#,1) to stop the loop, where # is the PlayerIndex. 

FADE 

Performs a volume fade on the specified Player. 

Client sends: 

Field Value 

Command FADE [FA] 

PlayerIndex 1 to N 

PlayerVolume Final Volume gain in hundredth of dB (from 0dB to -100dB) 

FadeTime fade time (either timecode or millisecond format) 

FadeCurve 1 to 3 (selects from fade curves): 

1: Standard Logarithmic Audio Curve 

2: Crossfade Curve 

3: Linear Curve 

Server replies with the same message: 

Example: FADE(4,-1000,3000,1) 

SETMONO 

Set the Mono/Stereo configuration of the specified Player. 

Client sends: 

Field Value 

Command SETMONO [MO] 

PlayerIndex 1 to N 

MonoMode 1 for mono 0 for stereo 

Server replies with the same message: 

Example: SETMONO(8,1). 
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Request Commands 

GETSTATUS 

Get the short status for the specified Player. 

Client sends: 

Field Value 

Command GETSTATUS [GS] 

PlayerIndex 1 to N 

Server replies with the same message: 

Field Value 

Command GETSTATUS [GS] 

PlayerIndex 1 to N 

Status Status of the Player as an integer: 

0: Idle 

1: Open 

2: Close 

3: Playing 

4: Paused 

5: Stopped 

8: Locating 

9: NotOnline 

Position Position in timecode (hundredth of seconds format) 

Example: 

• Client sends: GETSTATUS( 4 ) 

• Server replies: GETSTATUS(4,3,00:05:23/45) 
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GETFULLSTATUS 

Get the status for the specified Player. 

Client sends: 

Field Value 

Command GETFULLSTATUS [GF] 

PlayerIndex 1 to N 

Server replies with the same message: 

Field Value 

Command GETFULLSTATUS [GF] 

PlayerIndex 1 to N 

Status Status of the Player as an integer: 

0: Idle 

1: Open 

2: Close 

3: Playing 

4: Paused 

5: Stopped 

8: Locating 

9: NotOnline 

MediaName Name of the currently loaded media (empty if no media) 

Position Position in timecode (hundredth of seconds format) 

Duration Duration of the currently loaded media in timecode (hundredth of seconds format) 

Volume Level attenuation in hundredth of dB (from 0dB to -100dB) 

Balance Current balance 

OpenFileCounter Open File counter. The value is incremented each time a new file is opened on the specified Player. 

PlayCount Count of programmed loops (0 means infinite loop) 

Example: 

• Client sends: GETFULLSTATUS( 4 ) 

• Server replies: GETFULLSTATUS(4,playing,testfile.wav,00:05:23/45,00:10:00/00,0,0,55,1) 

GETPOSITION 

Get the position of the current media for the specified Player. 
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Client sends: 

Field Value 

Command GETPOSITION [GP] 

PlayerIndex 1 to N 

Server replies with the same message: 

Field Value 

Command GETPOSITION [GP] 

PlayerIndex 1 to N 

Position Current position in timecode (hundredth of seconds format) 

Example: 

• Client sends: GETPOSITION ( 4 ) 

• Server replies: GETPOSITION (4,00:05:23/45) 

GETDURATION 

Get the duration of the current media for the specified Player. 

Client sends: 

Field Value 

Command GETDURATION [DU] 

PlayerIndex 1 to N 

Server replies with the same message: 

Field Value 

Command GETDURATION [DU] 

PlayerIndex 1 to N 

Duration Duration of current media in timecode (hundredth of seconds format) 

Example: 

• Client sends: GETDURATION(4) 

• Server replies: GETDURATION(4,00:05:23/45) 
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GETVOLUME 

Get the current volume gain of the specified Player. 

Client sends: 

Field Value 

Command GETVOLUME [GV] 

PlayerIndex 1 to N 

Server replies with the same message: 

Field Value 

Command GETVOLUME [GV] 

PlayerIndex 1 to N 

Volume Level attenuation in hundredth of dB (from 0dB to -100dB) 

Example: 

• Client sends: GETVOLUME(4) 

• Server replies: GETVOLUME(4,-1000) 

GETBALANCE 

Get the current balance of the specified Player. 

Client sends: 

Field Value 

Command GETBALANCE [GB] 

PlayerIndex 1 to N 

Server replies with the same message: 

Field Value 

Command GETBALANCE [GB] 

PlayerIndex 1 to N 

Balance Balance in hundredth of dB. Positive values for right channel, negative values for left channel. 

Example: 
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• Client sends: GETBALANCE(4) 

• Server replies: GETBALANCE(4,1000) 

GETCURRENTMEDIA 

Get the name of the current media for the specified Player. 

Client sends: 

Field Value 

Command GETCURRENTMEDIA [GM] 

PlayerIndex 1 to N 

Server replies with the same message: 

Field Value 

Command GETCURRENTMEDIA [GM] 

PlayerIndex 1 to N 

MediaName Name of the currently loaded media (empty if no media) 

Example: 

• Client sends: GETCURRENTMEDIA ( 4 ) 

• Server replies: GETCURRENTMEDIA (4,testfile.wav) 

GETMEDIADIRECTORY 

Get the media directory of the whole audio server. 

Client sends: 

Field Value 

Command GETMEDIADIRECTORY [GD] 

Server replies with the same message: 

Field Value 

Command GETMEDIADIRECTORY [GD] 

MediaDirectory Path of the current media directory 

Example: 
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• Client sends: GETMEDIADIRECTORY() 

• Server replies: GETMEDIADIRECTORY(c:\sounds) 

GETFILELIST 

Get the list of the files located in the media directory of the audio server. 

Client sends: 

Field Value 

Command GETFILELIST [LI] 

Server replies with the same message: 

Field Value 

Command GETFILELIST [LI] 

FileList File list with filenames separated by CR/LF pairs (0x13,0x0D) 

Example: 

• Client sends: GETFILELIST() 

• Server replies: GETFILELIST(testfile.wav\r\nring.wav\r\nhello.wav) 

The following characters are not allowed in the filenames: 

• ‘,’ comma 

• ’)’ right bracket 

• ‘(‘ left bracket 

GETVERSION 

Get the version of MAS Pro software and the version of the ASCII protocol. 

Client sends: 

Field Value 

Command GETVERSION [VE] 

Server replies with the same message: 
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Field Value 

Command GETVERSION [VE] 

SoftwareVersion Current version MAS Pro 

ProtocolVersion Current version of ASCII protocol 

Example: 

• Client sends: GETVERSION() 

• Server replies: GETVERSION(1.0.7.0,1.0) 

o Software version is “1.0.7.0”. 

o ASCII Protocol Version is “1.0”. 

7.3.3 Response Message 

Error List 

Possible values for error codes: 

• Syntax Error: input is malformed 

• Unknown Command: the command verb is not recognized 

• Invalid Channel: the specified channel index is incorrect 

• Parameter Count: the count of parameters of the command is incorrect 

• File Not Found: the specified media name was not found in the media directory 

• Invalid Time: the time parameter of the command is invalid 

Channel Status 

The status field of the reply message to the GetStatus command can have one of the following 
values: 

• Idle: initial state after power up 

• Open: a media has been successfully opened and loaded 

• Close: last OPENMEDIA() command failed 

• Playing: the media is currently playing 

• Paused: the media is currently paused 

• Stopped: the media is currently stopped 
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• Locating: the media is reaching its target position 

• NotOnline: the channel is not online 

7.4 Keyboard Shortcuts 

7.4.1 File menu 

Item Shortcut Action 

Quit Ctrl+Q Quit the application 

 

Note that this menu is not available locally on the MAS Pro user interface. 

7.4.2 Configuration menu 

Item Shortcut Action 

New Configuration Ctrl+N Create a new empty configuration 

Open Configuration Ctrl+O Open and load an existing configuration file 

Save Configuration Ctrl+S Save the current configuration to disk 

Edit Configuration Ctrl+E Edit the current configuration 

7.4.3 Server menu 

Item Shortcut Action 

Connect Ctrl+Alt+K Launch Medialon Audio Server Browser 

Disconnect Shift+Ctrl+K Close current Medialon Audio Server connection 

Retrieve Configuration 
from Audio Server 

Ctrl+R Retrieve the configuration from Audio Server to the remote Audio Client 

Transmit Configuration 
to Audio Server 

Ctrl+T Transmit the configuration from the remote Audio Client to the Audio Server 

7.4.4 Help menu 

Item Shortcut Action 

Medialon Audio Client PRO Help F1 Launch Medialon Audio Server User Manual 
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7.4.5 Configuration Editor 

Item Shortcut Action 

New Player Ctrl+P Create a new Player 

New Track Ctrl+T Add a new track to the selected Player 

Output Mapping Ctrl+M Open the Output Mapping for the selected Track 

7.5 Action on click 

7.5.1 Player Index click 

Opens the Player details window. 

7.5.2 Player Media Name click 

Opens the Media Library window. 

7.5.3 Ctrl + Volume click 

Set all volume sliders to the same level: 

• In the main window, it concerns all Players volumes. 

• All tracks levels change in a Player Detail. 

• All output volumes are set in Output Control window 

7.6 Help 

 

7.6.1 About Dialog 

Clicking on the “Help > About...” menu item displays the “About...” dialog box. 
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The program version is shown at the bottom left of the box 
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8 Contact Us 

Find more on our website https://www.medialon.com/ and on social media 

 

or contact our support team at support@medialon.com 

 

 

 

https://www.medialon.com/
mailto:support@medialon.com




 

 

 

 



 
 
 

 

7thSense Design Ltd, UK 
(registered address) 

2 The Courtyard 
Shoreham Road 
Upper Beeding 
West Sussex 
BN44 3TN 
UK 
 
T: +44 (0) 1903 81229 
 

E: support@medialon.com 
W: medialon.com 

7thSense Design Ltd, US 

 
4207 Vineland Rd. 
Suite M1 
Orlando 
FL 32811 
USA 
 
 
T: +1 407 505 5200 
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